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ABOUT CHANCERY SMS
Welcome to Chancery SMS® from Chancery Software. Chancery SMS is a 
software tool for managing student and family information in your school 
district. District and school staff, such as district administrators, teachers, 
school counselors, and school administrators, use Chancery SMS to access 
important school and district data. 

What You Should Know
Before you use Chancery SMS, you should be comfortable with the 
Windows® or Macintosh® environments and know how to use an Internet 
browser.

This document assumes that you already know how to:

• use a mouse

• work with scroll bars, checkboxes, and radio buttons

• select, enter, and edit text

• cut, copy, and paste text

• select options from dropdowns

• identify and click links on a web page

• refresh a web page

• print

Using Online Help
In addition to this guide, Chancery Software offers online Help to assist you 
with your day-to-day tasks.

1 On the task bar on any page, click Help.

2 From the Help menu, click Contents.

3 In the online Help, in the right-hand pane, under Contents, click the topic 
in which you are interested.

OR

Click Index to access the online index.

OR

Click Search and type in the word or words you want to search for.
About Chancery SMS
What You Should Know
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QUICK TOUR
This section provides a quick overview of the main features of Chancery 
SMS.

Starting
You start Chancery SMS from Internet Explorer®. To work with 
Chancery SMS pages, log on using your user ID and password.

TO START CHANCERY SMS:
1 Open Internet Explorer.

2 In the Address bar, enter the address of your district web application 
server. Press Enter.

The Chancery SMS Log On page opens. You may want to add it to your 
list of Favorites in the browser.

3 Enter your Chancery SMS user ID and password. If your district uses a 
directory service, enter the domain name for Chancery SMS.

4 Click Log On.

5 If you do not have a default role, the Choose Role dialog opens. Select the 
default role that you would like to enter automatically each time you log 
on. After logging on, you can switch roles by clicking Switch Role from 
the Actions menu.

Navigating
You navigate in Chancery SMS much the same way as you do in a web 
browser. Chancery SMS pages display like a web application. You move from 
page to page to complete tasks and start new ones.
Quick Tour
Starting
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Each Chancery SMS page has four parts: 

• breadcrumbs

• a control bar

• a content area

• a task bar

Control bar
Use these links to 
move to different 
areas within 
Chancery SMS.

Content area
Work with information 
in the content area.

Task bar
The links across the top of the page 
make up the task bar. You have access to 
the Actions, Edit, Reports, and Help 
menus, along with Home and Log Off 
options.

Breadcrumbs
Breadcrumbs indicate 
what page you’re on 
and how you got there.
Quick Tour
Navigating
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Breadcrumbs
To help you keep track of where you are in the interface, refer to the 
breadcrumbs. Breadcrumbs display links to pages you accessed to reach the 
current page. Breadcrumbs are also a quick way to return to previously viewed 
pages.

Control Bar
The control bar is the vertical pane on the left side of the page. Click the links 
in the control bar to access the different areas of Chancery SMS. For example, 
to search for a student, click a search link, such as Student Search, Quick, 
Basic, or Detailed, to open the appropriate search page.

Content Area
The content area is the main part of the page. It is divided into collapsible 
panels that group information in logical and meaningful ways. A panel can 
contain any combination of fields, dropdowns, checkboxes, grids, buttons, 
icons, and links needed to support the particular feature area.

Task Bar
Click the task bar menus to display dropdown menus where you can select 
options. For example, you can use an option in the Actions menu to register 
and enroll a student.

Working with Chancery SMS
District and school staff, such as district administrators, teachers, school 
counselors, and school administrators, use Chancery SMS to access important 
school and district data. For example, school administrators can create the 
school schedule, take daily attendance, and view or edit district-wide student 
demographic information.

To go back to a page you 
have visited in the current 
session, click a link in the 
breadcrumbs trail.

Indicates the page 
on which you are 
currently working.
Quick Tour
Working with Chancery SMS
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Use Chancery SMS to work with important student information in real time. 
For example, school staff can take attendance, enter grades and view student 
demographic information while in the classroom.

Understanding the Interface
Chancery SMS is a web-based application designed to be familiar to anyone 
who has used a web browser. The following diagram details each part of 
Chancery SMS. For more information about using Chancery SMS, from the 
Help menu, click an option such as Contents.

Tips & Shortcuts
This section provides tips and shortcuts to help you work more efficiently and 
effectively with Chancery SMS.

Optimizing Screen Space

Most of the pages in Chancery SMS are optimized for 800 x 600 screen 
resolution. You can change your computer settings to this resolution, if 
required.

To select all records, 
Click the Select All 
checkbox.

Browser 
toolbar

Highlighted text 
indicates where 
you are.

To move to the 
next or previous 
page, click Prev 
or Next.

Breadcrumbs indicate 
where you are and 
how you got there.

To return to your 
home page, click 
here.

To choose an 
option from the 
dropdown, click 
here.

To print the 
current page, 
click the Print 
icon.

To expand or 
collapse panels, 
click here.

To access online help and 
get further information 
about Chancery SMS, 
click here.

 To work with an item, click 
the checkbox next to it. To 
work with multiple items, 
click multiple checkboxes.
Quick Tour
Working with Chancery SMS
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On some pages, you’ll be working with several columns that are easier to view 
if you set your browser to view small icons. This is especially useful when 
entering grades. 

TO CHANGE YOUR SCREEN RESOLUTION: 
1 Right-click your desktop and select Properties from the menu.

2 In the Display Properties dialog, click the Settings tab.

3 In the Screen area section, click and drag the marker to the appropriate 
setting. 

4 Click OK to apply the new settings. Click OK to accept the change.

TO CHANGE YOUR BROWSER ICON VIEW:
1 Start Internet Explorer.

2 From the Internet Explorer View menu, click Toolbars > Customize.
Quick Tour
Working with Chancery SMS
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3 In the Customize Toolbar dialog, from the Icon Options dropdown, 
select Small Icons.

4 Click Close.

User Permissions and Scope

Not all areas of Chancery SMS are accessible to all users. Your role controls 
which pages you see and what data you can work with. Each role has a set of 
permissions and a scope that is either for a specific school or for the entire 
district.

For example, teachers or data entry clerks typically do not have access to the 
School Setup pages. School users access data for the schools to which they are 
assigned. District users are not associated with a school. Instead, district users 
access information that is district-wide, such as student demographic and 
enrollment information. 

Alert Messages

Alert messages alert district and school staff to important information. For 
example, when someone marks a student absent for a future date, an alert 
message is immediately sent to that student’s teacher. The message appears on 
the teacher’s homepage.

When you receive a new alert, the Alerts area on your home page shows the 
number of new alerts, and the task bar on all pages shows an alert message 
icon ( ). To view your alerts, either click the alert icon or click the new alerts 
link on your home page.
Quick Tour
Working with Chancery SMS
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In order to receive alerts, you must subscribe to them. For further details, see 
“Working with Alerts” on page 15. 

Opening a Record

You can often access the same data in different ways, depending on the task. 
For example, to access a student record, you can:

• Click the Roster ( ), Grading ( ), or Attendance ( ) icon on the 
My Classes page, then click the student’s name on the Roster, Class 
Roster, Grades, or Attendance page.

• Perform a student, quick, basic or detailed search, then click the student’s 
name on the Student Search Results page. For detailed information about 
searching see “Searching for Student Records” on page 21.

• Search by family name, click the student’s family name on the Family 
Search page, and then click the student’s name on the Family Overview 
page. This is useful if a student’s siblings or guardians have different last 
names. For more information, see “Performing a Family Search” on 
page 36.

• Open a saved list and click the student’s name on the Student Search 
Results page. For more information, see “Saving Your Search Results” on 
page 33.

If Pages Don't Appear Right Away

If you click a button and the page you want does not appear right away, be 
patient. Do not click the button again or click any other buttons while you’re 
waiting for the page to open—your server might be temporarily busy.

On some secondary pages, while your request is processed, the animated 
Chancery icon  appears.

If you stop using Chancery SMS for a while, the software may “time out” as a 
security measure - meaning you are automatically logged off. If that happens, 
you need to log on again. If you did not save your work before leaving 
Chancery SMS, you might have to redo some work.
Quick Tour
Working with Chancery SMS
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Checkboxes

When you are working with a list of records, such as a list of students, notice 
the checkboxes to the left of each list item. To select an item, click the 
checkbox. To select multiple items, click each checkbox.

Checkbox - Select All

To select all records in a list that might span multiple pages, not just the 
records on the current page, click the Select All checkbox. For example, your 
Student Search Results might include more than 100 students that span 
multiple pages. To select all students in that list of Search Results, click the 
Select All checkbox.

The Select All checkbox is found at the top of a list of records.

Quick Sort

To quickly sort a list of records, such as search results, click any underlined 
column heading. For example, to sort by gender, click the Gender column. To 
change the sort order, click the column heading again. The order of the 
records remains the same until you change it.

Click an underlined 
column heading to sort 
by that column.

A down arrow 
indicates descending 
order.

An up arrow indicates 
ascending order.
Quick Tour
Working with Chancery SMS
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Customize Display Options

You can customize the column display to suit your needs. Changes you make 
remain until you change the column display again.

TO CUSTOMIZE THE COLUMN DISPLAY:
1 On a Student Search Results page, from the Edit menu, click Choose 

Columns.

2 In the available columns list, select the column you want to display.

3 Click  to move your selection to the Selected Columns list. 

4 Use the up and down buttons to move the columns to where you want 
them to be on the page. The higher the column is in the list, the further to 
the left it is on the page.

5 Repeat steps 2 to 4 until you have all the columns you want and in the 
order you want them to display on the page.

6 Click OK.

Panels

Information is grouped on a page in panels that are collapsed or expanded by 
default based on the way the page is designed to be used. To expand or 
collapse a panel, click  or .

Using Keyboard Shortcuts to Move Between Fields

You can use your keyboard to move from field to field on a page.

• To move to the field on the right, press Tab.

• To move to the field on the left, press Shift+Tab.

To display a column, 
click an item in the 
Available Columns 
list, then click the 
add arrow.

To remove a column, 
click the item in the 
Selected Columns 
list, then click the 
remove arrow

To set the column 
display order, select 
an item, then click the 
up or down arrow.
Quick Tour
Working with Chancery SMS
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Printing a Page

You have the option of printing one page, or printing a list of items that span 
multiple pages.

TO PRINT AN ENTIRE PAGE:
• Click the browser Print button.

TO PRINT A LIST OF ITEMS THAT SPAN MULTIPLE PAGES:
1 Click the Print icon ( ). The Print options page appears. 

2 In the Print options window, make your selections.

3 Click Print. The report appears in the PDF Viewer. 

4 In the PDF Viewer, click the Print button.

Printing Reports

Chancery SMS comes with many predefined reports that you can print from 
the Reports menu on the associated page or from the page.

Warning

When printing a report, do NOT click  to cancel the report as this will slow 
system performance considerably.

Logging Off

To end your current work session, log off from Chancery SMS.

Warning

For security reasons, make sure you log off from Chancery SMS when you finish 
your current session. Otherwise, unauthorized users are able to access the system 
until your session times out.

Save

Print
Find
Quick Tour
Working with Chancery SMS
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TO LOG OFF FROM CHANCERY SMS:
• In the Chancery SMS task bar, click Log Off.

Note

To close Chancery SMS, use Log Off in the task bar, do not click the in 
your browser.
Quick Tour
Working with Chancery SMS
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USING YOUR HOME PAGE
When you first log on to Chancery SMS, your home page opens. For teachers 
in a school using Chancery SMS, the My Classes page is the home page. 

The right side of your home page includes an Alerts section to give you quick 
access to alerts, and a Scheduled Events section, which displays reports and 
exports that have been scheduled. The left side of the home page displays all 
the classes to which you are assigned.

To navigate back to your home page from another page, click Home in the 
task bar. For more information on navigating around your homepage, see 
“Navigating” on page 3.

If you have new alerts, the task bar shows an alert message icon ( ).

Working with Alerts
To receive alerts, you must subscribe to them. For example, if you subscribe 
to the Future Attendance Change alert and someone enters an absent 
attendance type code for a future date, an alert message is immediately sent to 
your home page. For further information about subscribing to alerts, see 
“Subscribing to and Viewing Alerts” on page 16.

When you receive new alerts, the Alerts area on your home page shows the 
number of new alerts and the task bar on all pages shows an alert message 
icon ( ). 

Classes to 
which you are 
assigned.

To view your 
alerts, click 
here.

To review 
scheduled reports 
or exports, click a 
link.

Alert icon
Using Your Home Page
Working with Alerts
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Chancery SMS checks for new alerts every five minutes, regardless of what 
page you are working on. Refreshing the page before five minutes has elapsed 
does not check for new alerts.

When Chancery SMS detects that you have new alerts, the alert icon appears 
in the task bar on every page. Once you open the Alert List page, the alert 
icon no longer appears, whether you read the new alerts or not.

Subscribing to and Viewing Alerts

You must subscribe to alerts to receive alert messages; however, the Alerts 
area always displays on your home page, even if you have not subscribed to 
any alerts. 

TO SUBSCRIBE TO ALERTS:
1 Log on as a teacher.

2 On your home page or on the Alert List page (when you view your alerts), 
from the Actions menu, click Change Alert Subscription.

3 Select the alerts you want to subscribe to.

4 Click OK.

Alert icon
Using Your Home Page
Working with Alerts
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TO VIEW ALERTS:
1 Log on as a teacher.

2 On your home page, click either the alert message icon ( ) or the new 
alerts link.

On the Alert List page, alerts display in reverse chronological order, with 
the most recent message first. Unread alerts display in bold. 

3 On the Alert List page, click a message to open the Open Alert page to 
read its contents.

OR

Select multiple alerts then, from the Actions menu, click Open Alert to 
read the first alert. To view another selected alert, use either the 
dropdown or click Prev or Next.

The top right of the Open Alert page shows when this alert will be 
deleted. Alerts are automatically deleted after 30 days, whether you have 
read them or not. You can manually delete alerts at any time.

TO DELETE AN ALERT IN THE ALERT LIST PAGE:
1 Log on as a teacher.

2 On your home page, click either the alert message icon or the new alerts 
link.

3 On the Alert List page, select one or more alerts.

4 From the Actions menu, click Delete Alert.

If you selected more 
than one alert, you can 
read the other selected 
alerts by clicking Prev or 
Next or by selecting an 
alert from the 
dropdown.
Using Your Home Page
Working with Alerts
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MY CLASSES
As a teacher, you are assigned to classes and/or homerooms in which you 
provide instruction to groups of students.

When you log on to Chancery SMS, your home page appears, which is the My 
Classes page by default. The My Classes page displays the specific classes 
and/or homerooms to which you are assigned.

Working with the My Classes Page
The My Classes page is the starting point of all navigation for you, as a 
teacher. For elementary teachers, the My Classes page displays your 
homeroom and other classes you are assigned to teach, as well as upcoming 
birthdays for students in your homeroom and classes.

For details on how to navigate around the My Classes page, see “Navigating” 
on page 3.

To view a class 
roster, click the 
Roster icon.

To enter grades, 
click the Grading 
icon.

To take attendance, 
click the Attendance 
icon.

To view alerts, run 
reports, and access 
Quick Links, click the 
appropriate link.View your student’s 

upcoming birthdays.

Elementary
My Classes page
My Classes
Working with the My Classes Page
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For secondary school teachers, the My Classes page also displays meeting 
patterns.

From the My Classes page, you can do the following:

• Access alerts, run reports, and access pages for which Quick Links have 
been created. For details, see “Using Your Home Page” on page 15.

• View the roster for a homeroom or class and view student demographic 
data. For details, see “Student Demographics in the Classroom” on 
page 41. 

• Enter grades for classes. For details, see “Grading in the Classroom” on 
page 45.

• Take attendance for classes. For details, see “Attendance in the 
Classroom” on page 49.

Secondary
My Classes page

View class term and 
meeting pattern.
My Classes
Working with the My Classes Page
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SEARCHING FOR STUDENT RECORDS
There are several ways to search for students in Chancery SMS:

At the top of the Quick Search page or at the top of any search results page 
(Quick, Basic, Detailed, or Saved List):

In addition, you can save your search results to Saved Lists for future use.

Performing a Student Search
The Student Search features a Basic search tab and a Detail search tab (these 
are separate from the Basic and Detailed searches available in the control bar). 
Use the Student Search Basic tab to search by common student demographic 
fields. Use the Student Search Detail tab to search by fields within categories, 
such as Personal or Enrollment.

To Use this search type

Select to search by demographic information (Basic) 
or by other specific criteria (Detail).

Student Search

View a pre-defined list of students, such as all your 
students in a grade level. You can also search by 
name or student ID.

Quick Search

Search by additional demographic information such 
as Phone, Birthdate, Age, and Grade.

Basic Search

Refine your search to include only those students 
that match specific criteria.

Detailed Search

Search for students or contacts within a family 
record.

Family Search

To Do this

Search by a student’s 
exact student number.

Enter the number in the “Last Name or ID” field.

Search for students 
whose last names start 
with certain letters, such 
as “Smi”.

Enter the letters in the “Last Name or ID” field.

Search for students 
whose first or preferred 
names start with certain 
letters, such as “Jen”.

Enter the letters in the “First or Preferred Name” field.
Searching for Student Records
Performing a Student Search
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TO SEARCH FOR STUDENTS USING STUDENT SEARCH BASIC TAB:
1 Log on as a teacher.

2 In the control bar, under Student, click Student Search.

3 On the Basic tab, use one of the following search options:

Search Option Description

Search by 1 Enter up to three search constraints. Enter a field, an 
operator, and a value. 

Choose from common student demographics fields, 
such as:
• Age
• Birthdate
• First or Preferred Name
• Last Name
• Gender
• Geocode 
• Grade Level
• Home School
• SSN/SIN
• Student Number
• Student Saved Lists
and so on.

2 Click Search.

Display all records Rather than search for specific students, you can display 
all students.
Note
Chancery SMS can display up to 1000 records. If there are 
more than 1000 records in the search results, you will need to 
narrow your search criteria.

List Choose from previously-used search criteria. For 
example, if you recently searched for students whose first 
name is Colin, that search criteria is saved to this list.

ValueField Operator
Searching for Student Records
Performing a Student Search
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TO SEARCH FOR STUDENTS USING STUDENT SEARCH DETAIL TAB:
1 Log on as a teacher.

2 In the control bar, under Student, click Student Search.

3 On the Detail tab, from the Category dropdown, select a category such as 
Enrollment or Registration.

4 Use one of the following search options: 

Performing a Quick Search
On your home page, under Quick Search, you can view all your students, your 
students in a specific grade, your recently enrolled students (within the past 30 
days), or any of your students who have withdrawn this year. In addition, use 
the “Last Name or ID” or the “First or Preferred Name” fields at the top of 
the Quick Search page to search for a specific student.

Search Option Description

Search by 1 Enter your search criteria. Enter a field, an operator, 
and a value. 

2 Click Add Criteria. To narrow the search result, add 
additional criteria.

3 Indicate whether to match all criteria or match any 
criteria. All criteria produces a narrow list that contains 
only those students who match all the criteria you 
specify. Selecting Any criteria broadens the search to 
include students who match any of the search criteria 
you specify.

4 Click Search.

Display all records Rather than search for specific students, you can display 
all students.
Note
Chancery SMS can display up to 1000 records. If there are 
more than 1000 records in the search results, you will need to 
narrow your search criteria.

List Choose from previously-used search criteria. For 
example, if you recently searched for students whose first 
name is Colin, that search criteria is saved to this list.

OperatorField Value
Searching for Student Records
Performing a Quick Search
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TO FIND A STUDENT USING A QUICK SEARCH:
1 Log on as a teacher.

2 In the control bar, under Student, click Quick.

3 On the Quick Search page, in the “Last Name or ID” field or the “First or 
Preferred Name” field, enter the student’s ID number, last name, or first 
name, or partial values of any of these.

OR

Do one of the following:

• In the Quick Search panel, click the student’s grade.

• In the Pre-defined Searches panel, click a pre-defined search.

The Search Results page displays a list of possible matches. If there are 
many students, you may need to scroll or click the Prev/Next paging 
controls to find the student you’re looking for.

4 To open a student record, click the student’s name.

Performing a Basic Search
A basic search is a precise way of finding students. For example, if you enter a 
student’s name and phone number, you’ll narrow your search results.

You don’t have to use all the search fields. Records are found that meet all the 
criteria you enter, while fields you leave blank are ignored. For example, if you 
enter a last name and a phone number, the results include only students who 
have both the last name and the phone number you specified.

For a list of all 
your students, 
click here.

Click a grade level 
for a list of all your 
students in that 
grade.

For a predefined 
list of your 
students, click a 
link.
Searching for Student Records
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If you’re not sure of the correct spelling of a student name, enter the first few 
letters. The results include names beginning with those letters. Use either 
upper or lower case letters. For example, searching for “lancaster” finds 
“Lancaster”. Enter spaces exactly. For example, searching for “delos santos” 
does not find “de los santos”.

TO FIND A STUDENT USING A BASIC SEARCH:
1 Log on as a teacher.

2 In the control bar, under Student, click Basic.

The Basic Search page opens.

3 On the Basic Search page, enter all or any of the following search criteria:

4 Click Search to display your search results.

Field Description

Student Name Search for all students with the same Last 
Name or all students with the same First or 
Preferred Name. If you’re unsure of the 
spelling, enter the first two or three letters.

Student ID Enter a complete Student ID.

Phone Enter the student’s home phone number

Current grade Select a specific grade level.

Geocode (Active) or 
Geocode (Planning)

Enter the student’s geographical region code 
for the current year or the coming year.

Birthdate Enter a birthdate in mm/dd/yyyy format.

Age/as of Enter a specific age and the date at which the 
age was calculated.
Searching for Student Records
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The Search Results page displays a list of possible matches. If there are 
many students, you may need to scroll down the page or click Prev/Next 
to find the student you’re looking for.

If you’re not satisfied with your search results, expand the Search Criteria 
panel to modify your search criteria, then click Search.

To choose the columns of data you want to display and to sort the data 
see “Customizing How Student Search Results Display” on page 31.

5 To open a student record, click the student’s name. 
Searching for Student Records
Performing a Basic Search
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Performing a Detailed Search
A detailed search is a good way to find a range of students who match a 
variety of criteria that you set.

In a detailed search, each of the criteria has three parts:

• a field name

• an operator

• a value

Field name Operator Value
Searching for Student Records
Performing a Detailed Search
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The following criteria finds students whose last name begins with “Sm” and 
would find Smith, Smythe, Small, and so on:

• Field Name = Last Name

• Operator = Starts with

• Value = Sm

To find students whose last name begins with “Sm” AND who are in Grade 
5, you would add the following criteria to the above search:

• Field Name = Grade Level (current)

• Operator = Is

• Value = 5

To reduce the number of students who match, select “All criteria”.

To to find only 
those students 
who match both 
criteria, select “All 
Criteria”.
Searching for Student Records
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The following criteria finds your students who are in Grade 5 OR Grade 6:

• Field Name = Grade Level (current)

• Operator = Is

• Value = 5; repeat for Value = 6

By searching for any criteria, you increase the number of students who match 
the criteria.

TO PERFORM A DETAILED SEARCH:
1 Log on as a teacher.

2 In the control bar, under Student, click Detailed.

3 From the Category dropdown, select the type of data you want to search 
for. Choose from:

• Most Frequent

• Personal

• Student Contacts

• Registration

• Enrollment

• Scheduling

4 From the left dropdown, select a field name.

5 From the middle dropdown, select an operator:

To find records where the field Use this operator

Includes the value anywhere in the field Contains

Ends with the value Ends with

Exactly matches the value Is

Is anything but the value Is not

To find students 
who match either 
criteria, select 
“Any Criteria”.
Searching for Student Records
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6 In the right field, enter or select a value from the dropdown.

Enter either upper or lowercase letters. For example, searching for 
“lancaster” finds “Lancaster”. Enter spaces exactly. For example, “delos 
santos” does not find “de los santos”.

7 Click Add Criteria.

8 To add more criteria to your search, repeat steps 3 through 7.

9 Select whether you want your search to match All criteria or Any criteria. 
Selecting All criteria produces a narrow list that contains only those 
students who match all the criteria you specify. Selecting Any criteria 
broadens the search to include students who match any of the search 
criteria you specify.

To remove criteria from the search, highlight the statement and click 
Remove.

10 Click Search.

The Search Results page displays a list of possible matches. If there are 
many students, you may need to scroll down the page, select a page from 
the dropdown or click the Prev/Next paging controls to find the student 
you’re looking for.

Starts with the value Starts with

Is greater than the value Greater than

Is less than the value Less than

Is greater than or equal to the value > or =

Is less than or equal to the value < or =

To find records where the field Use this operator
Searching for Student Records
Performing a Detailed Search



Chancery SMS in the Classroom Guide
If you’re not satisfied with your search results or no records are found, 
expand the Search Criteria panel, modify your search criteria, and then 
click Search.

To choose the columns of data you want to display and to sort the data 
see “Customizing How Student Search Results Display” on page 31.

11 To open a student record, click the student’s name.

Customizing How Student Search Results 
Display

You can customize the columns that display on the Student Search Results 
page to suit your needs. You can specify the columns that display, as well as 
sort the data in each column.

For example, if you are compiling a list of students whose parents need to be 
contacted, you might choose the following columns:

• Name

• Homeroom

• Student phone number

• Grade

You could then sort the data in the columns any way you want; for example, 
by Name and Student phone number, or by Grade and Homeroom, and so 
on.

TO SELECT COLUMNS TO DISPLAY:
1 Log on as a teacher.

2 Perform a search.
Searching for Student Records
Customizing How Student Search Results Display
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3 On a Student Search Results page, from the Edit menu, click Choose 
Columns.

4 In the available columns list, select the column you want to display.

5 Click  to move your selection to the Selected Columns list. 

6 Use the up and down buttons to move the columns to where you want 
them to display on the page. The higher the column is in the list, the 
further to the left it is on the page.

7 Repeat steps 4 to 6 until you have all the columns you want and in the 
order you want them to display on the page.

8 Click OK.

TO SORT DATA IN COLUMNS:
1 Log on as a teacher.

2 Perform a search.

3 On the Student Search Results page, from the Edit menu, click Sort.

To display a column, 
click an item in the 
Available Columns 
list, then click the 
add arrow.

To remove a column, 
click the item in the 
Selected Columns 
list, then click the 
remove arrow.

To set the column 
display order, select 
an item, then click the 
up or down arrow.
Searching for Student Records
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4 On the Sort page, click the appropriate dropdown and select an option. 
For example, you might want to sort the list of students in ascending 
order by Grade, then by Homeroom.

Note

You can sort data by columns that are not visible on the screen. For example, 
you might not want to see the Gender column, but you can still sort by 
gender.

5 Click OK.

Saving Your Search Results
In addition to the pre-defined searches available in Chancery SMS, you can 
save your custom search results to a saved list for future use. For example, you 
could save a list of students who are volunteering for the Food Bank. You can 
also create a new saved list from scratch or edit an existing saved list.

Understanding Saved Lists
A saved list is a static list of students that you manually update as needed. For 
example, when more students join the volunteer program, the additional 
students are not included in the saved list until you manually update the saved 
list to include those students.

In another example, if you create a saved list of grade 9 students and one or 
more students has a grade level change, the students remain in the grade 9 
saved list until you remove them, even though their grade level is no longer 9.
Searching for Student Records
Saving Your Search Results
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It’s important to note, however, that any changes you make to a student’s 
demographic data are automatically updated in the student record in the saved 
list. 

TO SAVE YOUR SEARCH RESULTS AS A SAVED LIST:
1 Log on as a teacher.

2 Perform a search.

3 On the Student Search Results page, select the students you want to save 
to a list.

4 From the Actions menu, click Save to List.

5 On the Save to List page, select Create New List, and enter an appropriate 
list name and description.

OR

To replace an existing list, select Add to Existing List, and then select a list 
from the List Name dropdown.

Note

Add to Existing List does not append your saved list to an existing saved list; 
rather, it replaces the existing list. To append names to an existing saved list, 
edit the saved list.

6 Click OK.

Creating and Editing a Saved List
You can create a saved list from scratch. You can also edit any saved list, 
whether they are created from scratch or created from search results.

TO CREATE AND EDIT A SAVED LIST:
1 Log on as a teacher.

ONLY select this 
option if you 
want your new 
list to replace the 
existing list.
Searching for Student Records
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2 On the Quick Search page, in the Saved Lists panel, click Edit.

3 To create a new saved list, from the Actions menu, click Add Saved List.

OR

To edit an existing saved list, on the Saved List page, click the list name 
you want to edit.

4 Enter or change the List Name and Description.

5 Enter your search criteria in the Last Name and First Name fields and 
click Search.

6 To add the student, select the student from the Search Results list and 
click Add.

OR

To delete a student from the saved list, select the student from the List 
Members list and click Remove.

7 Click OK.

TO DELETE A SAVED LIST:
1 Log on as a teacher.

2 On the Quick Search page, under Saved Lists, click Edit.

3 On the Saved List page, select the saved list you want to delete. From the 
Actions menu, click Delete Saved List.

4 Click OK.

Enter the name of 
the students you 
want to include in 
the saved list and 
click Search.

Select a student 
and click Add.
Searching for Student Records
Saving Your Search Results
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Performing a Family Search
If Family Management is activated when Chancery SMS is installed, students, 
siblings, and contacts are grouped by Family.

Finding Families
The Family Search features a Basic search and a Detail search (these are 
separate from the Basic and Detailed searches in the control bar). Use the 
Family Search Basic tab to search by common student demographic fields. 
Use the Family Search Detail tab to search by fields within categories, such as 
Student Contacts.

Here are some tips for improving your Family search results:

• The more fields you use, the more refined your search results are. You 
don’t have to use all the search fields. Fields you leave blank are ignored.

• If you’re not sure of the correct spelling of a name, enter the first few 
letters. Families whose names begin with the letters you type are found.

• Use either upper or lower case letters. For example, searching for 
“lancaster” finds “Lancaster”.

• Enter spaces exactly. For example, searching for “delos santos” does not 
find “de los santos”.

Note

You can also access a Family record when viewing the record of any students 
in that family. Open a student record then, in the control bar, click Family. The 
Family Overview page for the selected student appears.

TO SEARCH FOR FAMILIES USING THE FAMILY SEARCH BASIC TAB:
1 Log on as a teacher.

2 In the control bar, click Family Search.
Searching for Student Records
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3 On the Basic tab, use one of the following search options:

TO SEARCH FOR FAMILIES USING THE FAMILY SEARCH DETAIL TAB:
1 Log on as a teacher.

2 In the control bar, click Family Search. On the Family Search page, click 
the Detail tab.

3 On the Detail tab, from the Category dropdown, select an option, such as 
Personal or Student Contacts.

Search Option Description

Search by 1 Enter up to three search constraints. Enter a field, an 
operator, and a value. 

Choose from common student demographics fields, 
such as:
• Contact Last Name
• Contact Phone Number
• Family Name
• Family Number
• First Name
• Last Name
• Student Number
• Student Saved Lists

2 Click Search.

Display all records Rather than search for specific families, you can display 
all families.
Note
Chancery SMS can display up to 1000 records. If there are 
more than 1000 records in the search results, you will need to 
narrow your search criteria.

List Choose from previously-used search criteria. For 
example, if you recently searched for a family with the last 
name Smith, that search criteria is saved to this list.

OperatorField Value
Searching for Student Records
Performing a Family Search
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4 Use one of the following search options:

Viewing Family Information
On the Family Overview page and the Family Overview dialog, you can view 
information about a family, such as siblings, contacts and phone numbers. 

1 Log on as a teacher.

2 Perform a family search.

3 On the Family Search results page, click the link for a family.

Search Option Description

Search by 1 Enter your search criteria. Select the category of data 
you want to search, then enter a field, an operator, and 
a value. 

2 Click Add Criteria. To narrow the search result, add 
additional criteria.

3 Indicate whether to match all criteria or match any 
criteria. If you select All criteria, the search results 
include only those families who match all the search 
criteria you specified. Selecting Any criteria includes a 
list of families who match any of the criteria you 
specified.

4 Click Search.

Display all records Rather than search for specific families, you can display 
all families.
Note
Chancery SMS can display up to 1000 records. If there are 
more than 1000 records in the search results, you will need to 
narrow your search criteria.

List Choose from previously-used search criteria. For 
example, if you recently searched for a family with the last 
name Smith, that search criteria is saved to this list.

OperatorField Value
Searching for Student Records
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4 On the Family Overview page, in the header, click Edit to view family 
details.

The Family Overview dialog opens.

5 When you have finished viewing the family data, close the Family 
Overview dialog.
Searching for Student Records
Performing a Family Search
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STUDENT DEMOGRAPHICS IN THE 
CLASSROOM

As a teacher, you can view demographic data for your students, such as age, 
grade, homeroom, address, phone number, family information and so on. 

Working with Student Demographics Data
From the Student Demographics page, you can view basic student 
information as well as open other pages, such as the student’s attendance, 
grades or schedule page.

Opening a Student Record 
You can open a student record in several ways:

• Click the Roster ( ), Grading ( ), or Attendance ( ) icon on 
the My Classes page, then click the student’s name on the Roster, 
Class Roster, Grades, or Attendance page.

• Perform a student, quick, basic or detailed search then click the 
student’s name on the Student Search Results page. For details about 
searching for student records, see “Searching for Student Records” on 
page 21.

• Search by family name, click the student’s family name on the Family 
Search page, and then click the student’s name on the Family 
Overview page. This is useful if a student’s siblings or guardians have 
different last names. For details about searching by family, see 
“Performing a Family Search” on page 36. 

Click a student’s 
name to open their 
student record.
Student Demographics in the Classroom
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• Open a saved list and click the student’s name on the Student Search 
Results page. For information on saved lists, see “Saving Your Search 
Results” on page 33.

Viewing Student Demographic Data
On the Student Demographics page, view the student’s age, grade level, 
language spoken at home, as well as student data specific to your school, such 
as current grade level and homeroom. You can also view the student’s primary 
contact names and phone numbers. Scroll down the page to see the student’s 
phone number and address. 

• To view additional student information, click the following links in the 
control bar:

Link Description

Family This link opens the Family Overview page. This page 
displays the family number and name, and includes the 
following panels:
• Students – student name, home school, grade, and 

student-specific contacts
• Contacts – family contacts

Photo This link opens the Student Photo page. This page 
displays the student’s photo.

Attendance This link opens the student’s attendance page. For details, 
see “Attendance in the Classroom” on page 49.
Student Demographics in the Classroom
Working with Student Demographics Data



Chancery SMS in the Classroom Guide
Grades This link opens the students’ Grades page. For details, see 
“Grading in the Classroom” on page 45.

Credits (secondary only) This link opens the Student Credits page. This page 
displays the credits the student has received, including the 
associated grade item, grade, potential credits, credits 
earned, an override indicator, and override reason, if 
applicable.

Schedule This link opens the Student Schedule page. This page 
displays the term, meeting pattern, class name, teacher, 
and room for the student’s classes.

Student Behavior This link opens the Student Behavior page, which 
displays the student’s behavior incidents.

Award This link opens the Award page. This page lists all the 
awards the student has received, including the date on 
which the award was presented.

Registration This link opens the Registration page. This page displays 
the student’s registration information, such as the grade 
the student was in when he or she registered and the 
student’s registration status.

Program Profile This link opens the Program Profile page. This page 
displays information about programs the student is 
enrolled in, as well as programs to which the student has 
applied.

Test Results This link opens the Student Test Results page. This page 
displays a list of all the student’s test results that have 
been entered, including the test date, school at which the 
test was taken, the student’s grade level, whether the test 
was waived, and any comments.

Link Description
Student Demographics in the Classroom
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GRADING IN THE CLASSROOM
Chancery SMS provides two ways for you to capture grades for students in 
the classroom:

• Enter grades for all the students on a homeroom or class roster. See 
“Entering or Editing Grades from a Roster” on page 45.

• Enter grades for an individual student. See “Entering or Editing 
Individual Student Grades” on page 47.

Entering or Editing Grades from a Roster
If you enter grades by homeroom, you enter grades for all subjects taught to 
all students in the homeroom. If you enter grades by subject or class, you 
enter grades for specific class rosters.

The method for entering grades is the same whether you are entering grades 
for an elementary school or a secondary school.

To select the subject or class you want to enter 
grades for, select a subject or class from the 
dropdown, or click the Prev or Next link.

To select a grading 
period, click the 
dropdown.

To indicate the 
number of grading 
columns you want to 
display on the page, 
click the dropdown.

To enter a comment 
for the grading 
period, click the 
Comment icon.

To assign a grade, 
select a code from the 
dropdown.
Grading in the Classroom
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TO ENTER OR EDIT GRADES BY ROSTER:
1 Log on as a teacher.

2 On the My Classes page, click the grading icon ( )for a homeroom or 
class.

3 On the Grades page, configure the onscreen display by doing any of the 
following:

4 You can enter grades on the Grades page using two methods:

To Do this

Select the subject or 
class you want to enter 
grades for

• Click the Next or Prev links or select a subject or class 
from the dropdown.

Change the number of 
grade columns

• From the “No. of grade columns” dropdown, select 
the number of columns.

Enter grades for a 
different grading period

• Select a different grading period from the dropdown.
Note
The display defaults to the current grading period.

Change the columns 
displayed

1 From the Edit menu, click Choose Columns.
2 On the choose columns page, highlight a column in 

the Available Columns list and click the arrow button 
to move columns to the Selected Columns list. 

3 To determine the display order of the columns, use the 
up and down arrows. 

4 To return to the Grades page, click OK.

To Do this

Enter or edit grades for 
one student at a time 

• From the dropdown in each grade column, select a 
grade.

Enter or edit the same 
grade for multiple 
students

1 If you want to enter the same grades for selected 
students only, select the students. If you want to enter 
the same grades for all students in the roster, skip to 
step 2.

2 From the Edit menu, click Fill Columns.
3 Select whether you want to assign grades to selected 

students or all students on the Grades page.
4 Select whether you want to enter grades where no 

grades are specified or overwrite any existing grades.
Grading in the Classroom
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To determine which grades you are assigning, refer to the Legend at the 
bottom of the Grades page.

4 Click Save.

Entering or Editing Individual Student Grades
You can enter grades for an individual student from the Student 
Demographics page.

1 Log on as a teacher.

2 On the My Classes page, click a Roster icon.

3 On the Roster page, click the student’s name. 

4 On the Student Demographics page, in the control bar, click Grades.

The Student Grades page opens.

Select the number of 
grading columns you 
want to display.

To assign a grade, 
select a code from the 
dropdown.

Select a grading period 
from the dropdown.
Grading in the Classroom
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5 On the Grades page, configure the onscreen display by doing any of the 
following:

6 For each subject or class, enter or select grades from the dropdown.

To determine which grades you are assigning, refer to the Legend at the 
bottom of the Grades page.

To add a comment for a specific subject or class, click the Comment icon 
enter the comment, and then click OK.

.

7 Click Save.

To Do this

Change the number of 
grade columns

• From the “No. of grade columns” dropdown, select 
the number of columns.

Enter grades for a 
different grading period

• Select a different grading period from the dropdown.
Note
The display defaults to the current grading period.

Enter grades for courses 
from a different grade 
level

• Click the tab for the grade level.

Comment 
icon
Grading in the Classroom
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ATTENDANCE IN THE CLASSROOM
In Chancery SMS, attendance is taken by assigning an “attendance code” to 
each student’s attendance record. An attendance code describes a student’s 
attendance for either a day, a morning and afternoon, or a class (depending on 
whether your school takes attendance once daily, twice daily or by class). 

Chancery SMS provides three default attendance codes - Present, Absent 
Unexcused and Tardy Unexcused - and your school can add further 
attendance codes as required.

Depending on how your school is set up, the default attendance code that 
displays when you first open the attendance page is either Present or Absent.

Chancery SMS provides several ways for you to work with attendance in the 
classroom:

• Assign attendance to students in a homeroom or class roster. For details, 
see “Assigning Attendance to Students in a Roster” on page 49.

• Assign attendance to an individual student using the Student 
Demographics page. For details, see “Working with a Student’s 
Attendance Details” on page 52.

• Assign attendance by period. For details, see “Changing the My Classes 
View to Period Attendance” on page 54.

• Assign attendance to a group of students in a school where daily or 
twice-daily attendance is taken. For details, see “Assigning Attendance to 
Multiple Students from Different Rosters” on page 55.

As a teacher, you can assign current attendance and view past attendance. By 
default, only school administrators can assign attendance for future dates or 
modify past attendance, attendance entered by office staff, or submitted 
attendance.

Assigning Attendance to Students in a Roster
You can take attendance for your homeroom or class rosters for the current 
date. You can also update attendance for individual students, such as when a 
student is absent or late for school.

Your school can set up attendance so that it is taken for individual classes, 
independent of homeroom attendance. This is called supplementary 
attendance. If supplementary attendance is set up for a class, an attendance 
icon appears beside it on the My Classes page.
Attendance in the Classroom
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TO ASSIGN ATTENDANCE TO STUDENTS IN A ROSTER:
1 Log on as a teacher.

2 On the My Classes page, click the Attendance icon( ) for a 
homeroom or class, as appropriate. 

The Attendance page opens. The Attendance page is slightly different, 
depending on the type of attendance your school takes:

• If your school takes twice-daily attendance, a dropdown is available 
for selecting AM and PM attendance. Before you begin entering 
attendance, be sure to indicate whether you are taking AM or PM 
attendance.

• If your school takes class attendance, the class you are taking 
attendance for appears at the top of the page:

Click the dropdown to select a 
different class or use Prev and 
Next to take attendance for 
the previous or next class. 
Attendance in the Classroom
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The steps for entering attendance are the same no matter which 
attendance type your school uses.

3 On the Attendance page, do any of the following:

To Do this

Change the date, time of 
day, or meeting pattern 
for which you are taking 
attendance

• Click the calendar icon and select a different date (by 
default, teachers can only enter attendance for the 
current date).
OR
For twice-daily attendance, select AM or PM from the 
dropdown.
OR
For period attendance, select a different meeting 
pattern from the dropdown.

Mark a student as absent • Click the A Quick Entry button.

Indicates whether 
attendance has been 
submitted to the 
office.

To submit 
attendance to the 
office and log off 
from Chancery SMS, 
click here.

To mark a student as 
absent or tardy, click a 
Quick Entry button.

To submit 
attendance to 
the office, click 
here.

To enter a comment, click 
a checkbox or click in the 
Comment column.

Default attendance code is 
either Present or Absent, 
depending on how your school 
is set up.

If your school calculates 
minutes absent, enter that 
information here.
Attendance in the Classroom
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Note

Attendance can be automatically entered as a result of certain student 
behavior action steps. For example, a student who receives an out-of-school 
suspension may be automatically marked Absent for the suspension date 
range. Only users with specific permissions can override this attendance code.

4 Once you have entered the appropriate attendance information, do one of 
the following:

Note

If you have not submitted attendance by the end of the specified attendance 
collection time for your homeroom or class, you will receive an overdue 
attendance alert.

Working with a Student’s Attendance Details
You can enter attendance details for an individual student by accessing the 
Attendance page from his or her Student Demographics page.

1 On the My Classes page, click a Roster icon.

2 On the Roster page, click a student’s name.

3 On the Student Demographics page, in the control bar, click Attendance.

OR

Mark a student as tardy • Click the T Quick Entry button.

Assign a non-default 
attendance code

• From the Attendance column dropdown, select a 
code.

Enter a comment • Click in the Comment column, or click the checkbox.

View comments • Pause your cursor over the Comment icon ( ) for 
that student.

To Do this

Complete attendance for 
the selected time period 
and not submit it

From the Actions menu, click Save.

Send final attendance 
for the selected time 
period to the office and 
continue working in 
Chancery SMS

Click Submit.

Send final attendance 
for the selected time 
period to the office and 
log off 

Click Submit & Logoff.

To Do this
Attendance in the Classroom
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On any Student Search Results page, select a student and from the 
Actions menu, click Open Student > Attendance.

The Student Attendance page opens and displays attendance data for the 
selected student.

4 From the Date range dropdown, select the date range you want to edit or 
view.

5 Do any of the following:

To Do this

Enter an attendance 
code for the entire day

• For the appropriate date, in the Daily column, select 
the attendance code from the dropdown.

Enter an attendance 
code for a specific 
period

• For the appropriate date, in the specific period column 
or cell, select the attendance code from the dropdown.

View the student’s 
period schedule for the 
day

• For the appropriate date, pause the cursor over the 
Schedule icon.

To select a different 
date range (e.g., 
year to date), select 
an option from the 
dropdown.

Displays the months in 
the specified date 
range. To view the next 
and previous three 
months, click the Next 
or Prev controls.

To expand the panel 
and view a summary of 
daily attendance for the 
specified date range, 
click here.

To change the 
current date range, 
click here.

To view attendance 
codes for All days or 
Exception days only, 
select an option from 
the dropdown.

To change the 
current date range, 
click here.

If your school takes 
class attendance, 
attendance codes for 
each period display in 
separate columns.
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The Student Attendance page also displays Schedule icons (if your school 
takes class attendance) and Comment icons you can use to review 
additional information.

6 To record any changes, click Save.

Changing the My Classes View to Period 
Attendance

If your school takes daily or twice-daily attendance, skip this section.

The default view for the My Classes page is by class. You can change this view 
to show a list of the periods in which you are scheduled for classes for the 
current day. You can then take attendance for those periods.

View attendance-related 
comments

• For the appropriate date, pause the cursor over the 
Comment icon.

Add a comment 1 For the appropriate date, click the Comment icon.
2 In the Comments dialog, in the appropriate period 

field, enter the comment. 
3 Click OK.

View the student’s 
absenteeism and related 
staff comments

• In the date range header above the grid at the bottom 
of the page, select Exception Days Only.

Print the student’s 
summarized attendance 
information

• From the Actions menu, click Print Daily Summary.

Print the student’s 
detailed attendance 
information

• From the Actions menu, click Print Details.

To Do this

To view a comment, pause the 
cursor over a Comment icon.

To view schedule information, pause 
the cursor over a Schedule icon.
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When you change the My Classes page from the class view to the period 
attendance view, the Roster and Grading icons are no longer available; 
however, you can see these icons and access these pages any time by switching 
back to the default My Classes view.

TO CHANGE THE MY CLASSES VIEW:
1 Log on as a teacher.

2 On the My Classes page, from the Display by dropdown, select Day & 
Period (Attendance only).

3 From the Day dropdown, select the current day.

To take attendance, click the Attendance icon( ) for the class. For 
detailed information about how to take attendance, see “Assigning 
Attendance to Students in a Roster” on page 49.

To switch back to the classes view, on the My Classes page, in the Display 
By dropdown, select Classes.

Assigning Attendance to Multiple Students 
from Different Rosters

If your school takes class or period attendance, skip this section.

If your school takes once-daily or twice-daily attendance, you can assign the 
same attendance code to multiple students from different rosters. You can 
assign the group of students attendance for today or for a past date.
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TO ASSIGN THE SAME ATTENDANCE TO MULTIPLE STUDENTS 
1 Perform a search to locate the students you want to assign attendance to.

2 In the Search Results panel, select the applicable students and, from the 
Actions menu, click Mass Attendance.

The Mass Attendance page opens.

3 In the Start and To fields, enter a date range. By default, teachers can only 
enter attendance for today or past dates.

4 Depending on what type of attendance you’re entering, do one of the 
following:

To Do this

Assign homeroom 
attendance

1 From the Assign dropdown, select Homeroom 
Attendance.

2 From the To dropdown, select Full Day, AM or PM.
3 From the Attendance code dropdown, select the 

applicable attendance code.
4 In the Comments field, enter any applicable 

comments.
5 Click OK, then OK again in the confirmation dialog.

Assign daily attendance 1 From the Assign dropdown, select Daily Attendance.
2 From the Attendance code dropdown, select the 

applicable attendance code.
3 In the Comments field, enter any applicable 

comments.
4 Click OK, then OK again in the confirmation dialog.
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